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Overview
Many applications in the BarTender Suite store important application-specific information in the
BarTender System Database. For example, in BarTender Designer, you can save detailed information
about your print jobs or log application messages that you encounter. In Administration Console, you
can log security information about who accesses a particular application and when. And in Printer
Maestro, you can track printer inventory levels. This information, and more, is stored in the
BarTender System Database.

History Explorer makes it easy to view and monitor all of this information. You can also generate and
print reports of any data in the BarTender System Database.

History Explorer is available in all editions of BarTender. The Enterprise edition supports History
Explorer with no restrictions. The Automation edition supports the reprinting of documents and up to
seven days of logged data. The Professional and Free editions support up to seven days of logged
data; reprinted documents are printed in demonstration mode with a watermark.
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Logging Information to the System Database
History Explorer displays information that is saved to the BarTender System Database. To view the
information, you must first specify that the information is logged to the database.

For more information about how to configure the BarTender System Database, refer to the Setting
Up the BarTender System Database topic in the BarTender help system.

Logging Print Job Information
History Explorer can reprint one, more than one, or all of the items in a BarTender print job based on
the print job information that is stored in the BarTender System Database. To use this reprint
functionality, you must specify that print job information is logged to the BarTender System
Database. To do this, follow these steps:

1. In Administration Console, expand the System Database node in the left navigation pane if it
is not already expanded, and then click Print Job Logging.

2. On the Print Job Logging page, click to select the Log print job information check box.
3. In the Reprint area, click to select the reprint logging options that you want.
4. In the Images of Printed Items area, optionally click to select the Include image of the

printed item(s) check box, and then configure the items to include and the image settings.
When you do this, History Explorer can access an image of the print jobs that you specify in the
Items list. Be aware that this option uses a significant amount of space in the BarTender
System Database and can require more time to run BarTender print jobs.

5. Click Apply to apply your settings, or click OK to apply your settings and close Administration
Console.

For more information, refer to the Print Job Logging Page topic in the BarTender help system.

Logging Application Messages
History Explorer can display a list of the messages that are generated by certain applications in the
BarTender Suite. To log these messages to the BarTender System Database, follow these steps:

1. In BarTender, click Log Setup on the Administer menu. The Log Setup dialog opens.
2. Click to select the Log messages to System Database check box.
3. In the Severity Level list, select the severity level of the messages that you want to be logged

(errors, warnings, and/or information). To specify individual messages that you want to be
logged, select Custom, click Select, and then click to select the messages that you want. For
more information, refer to the Select Messages Dialog topic in the BarTender help system.

4. Click OK.
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The message severity levels have the following meanings: 

l Errors prevent you from printing an item or from using an application in the BarTender Suite.
l Warnings indicate events that may affect how an item is printed or how an application

behaves, but these events are not serious enough to cause a print job to fail or an application
to stop working.

l Information messages have no effect on the output of a print job or on the behavior of an
application.

Logging Security Permission Checks
Every time that a user tries to perform a protected action in any BarTender application, BarTender
can log the permission check. These checks can include allowed actions, electronic signatures,
logon overrides or encryption keys. History Explorer can display these permission checks if the
following conditions are true:

l You have set up security for your computer.
l You have configured some security permissions.
l You have enabled security logging.

For more information about how to configure security permissions, refer to the Security book of the
BarTender help system and the BarTender System Securitywhite paper:

https://www.bartendersoftware.com/resources/white-papers/

To set up security logging, follow these steps:

1. Open Administration Console.
2. Expand the Security node, and then click Logging.

History Explorer 5

http://help.seagullscientific.com/#../Subsystems/AdminConsole/Content/Security_LP.html
https://www.seagullscientific.com/support/white-papers


3. Scroll through the Action list to find the actions that you want, and then click to select the
check box for the permission checks that you want to be logged to the BarTender System
Database.

4. Click Apply to save your changes. Alternatively, click OK to save your changes and close
Administration Console.

History Explorer 6



Logging Printer Inventory Events, Print Jobs and Printer Events in Printer Maestro
When you configure event logging in Printer Maestro, History Explorer can display the printer
inventory events, print jobs and printer events that Printer Maestro logs. To do this, follow these
steps:

1. Open Printer Maestro.
2. On the Administer menu, click Events Setup. The Events Setup dialog opens.

3. In the left navigation pane, select BarTender System Database.
4. On the Events tab, click to select the Enable check box.
5. Under Event Selection, select the messages that you want to be logged.
6. Under Categories, click to select the Printer, Job and Inventory check boxes.
7. Click OK to close the Events Setup dialog.

For more information, refer to the Events Setup Dialog topic in the Printer Maestro help system.
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Using History Explorer

History Explorer Views
You can configure History Explorer to display different types of information according to the view that
you select in the View Selector pane. Several views are available, depending on the applications for
which you enabled logging.

BarTender Suite: Messages

When you select one of the filtering options in the BarTender Suite: Messages view, History
Explorer displays a list of messages that are stored in the BarTender System Database, which
come from all applications in the BarTender Suite for which message logging is enabled.

BarTender: Print Jobs

The BarTender: Print Jobs view displays all the jobs that you printed by using BarTender. By
default, they are listed chronologically in the order in which they were printed. Click a job to view
detailed print information, images of your items and status history.

To reprint any job, right-click it, and then click Reprint.
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To view more detailed information about a particular print job, click to expand it. Click to
collapse the print job details.

Printer Maestro: Print Jobs

The Printer Maestro: Print Jobs view displays information about all print jobs that were sent from
any application on your computer, not only BarTender jobs, as long as you are connected to the
Printer Maestro service.

Click to view a detailed status history for a selected print job.
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Printer Maestro: Printer Events

When the Printer Maestro service detects a printer event, it stores the event as a field in its
database. You can use the Printer Maestro: Printer Events view to sort these events by printer
so that you can monitor the printers that are installed on your computer.

Printer Maestro: Inventory Events

You can use Printer Maestro to track printer inventory, such as printer stock, ink and toner, or
hardware parts. When one of these tracked inventory levels changes status, you can view the
events by using the Printer Maestro: Inventory Events view.

Security: Permission Checks

The Security: Permission Checks view displays the security permission checks that are made by
applications in the BarTender Suite. These checks can include allowed actions, electronic
signatures, logon overrides or encryption keys.

History Explorer 10



Configuring the Interface
As with most of the other applications in the BarTender Suite, you can configure the layout of History
Explorer by sorting, adding, removing and resizing columns and panes.

Columns

You can sort, group and configure columns in the interface by using one or more of the following
methods:

l To sort columns by ascending order (A-Z, 0-9), click . Click to sort in descending order
(Z-A, 9-0).

l To reposition a column, drag the column header to the left or right.
l To add a column, right-click any column header to display the list of available columns, and

then click to select the column that you want to add.
l To remove a column, right-click any column header to display the list of available columns,

and then click to clear the column that you want.
l To resize a column, point to the column header until the resizing cursor ( ) appears, and

then drag the column to change its width.
l To group the information by a specific column, use one of the following methods: 

l Right-click a column header, and then click Group By This Column.
l Right-click a column header, click Show Group By Box, and then drag the column

header to the box.

Panes

You can resize, move, float, remove, or hide panes by using one or more of the following
methods:

l To resize panes, point to the side, top, or bottom of the pane. When you see the resizing
cursor ( or ), drag the pane to change its width or height.

l To move a pane so that it is docked to a different location, drag the pane name to the
location that you want, and then point to a docking arrow (for example:  ) to place the
pane.
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l To float a pane, drag a pane out of its current position, but do not point to a docking arrow.
When you do this, you can move the pane completely out of the History Explorer window to
view it separately. To re-dock a floating pane, drag it back to the History Explorer window,
and then point to a docking arrow.

l To remove a pane, click at the upper-right corner of a pane to remove it from the
History Explorer window. You can also choose which panes to display by using the History
Explorer View menu. You can restore the interface to its original configuration at any time
by clicking Restore Default View on the View menu.

l To hide a pane, click the auto-hide icon ( ) at the upper-right corner of a pane to move it to
a tab at the bottom of the History Explorer window. Point to the tab to view the pane. To
show the pane again, point to the tab to display the pane, and then click the dock icon ( )
at the upper-right corner.
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Searching and Filtering
History Explorer offers the following methods to search for and filter data:

l The BarTender: Print Jobs view provides a search field that you can use to search every object
in every print job within the specified time frame for the specified text.

l All History Explorer views include a navigation bar that you can use to browse through the
entries in the current view.

l You can use one of the built-in filter tools to help narrow down the results that appear. Each
view contains commonly used filters as sub-categories in the View Selector pane. If these
don't meet your filtering needs, you can set up custom filtering criteria by using the Custom
view.

l All History Explorer views (except custom views) include the following filtering tools:
l Time Span: Specifies a time span to filter by.

l Filter editor  : Opens a dialog box that provides a search field and other options that
you can use to filter the data by custom values.

For more information about how to filter data, refer to the Filtering Data topic of the BarTender help
system.

History Explorer 13

http://help.seagullscientific.com/#../Subsystems/HistoryExplorer/Content/Filter_Overview_HE.htm


Reprinting Print Jobs

Reprint Items Dialog
No matter where a print job originated from, History Explorer can redirect any reprint job to any
computer or printer on the network. Use the Reprint Items dialog, which appears whenever you
reprint items from History Explorer, to change the computer where you want the print job to originate
from or to change the printer so that you don’t have to recreate the original hardware and software
configuration. Even if you want to change to a completely different brand of printer that uses a
different printer language, you can reprint items from past print jobs.

Reprinting an Entire Print Job
To reprint an entire print job, locate the job in the BarTender: Print Jobs pane. Right-click the print
job, and then click Reprint.

History Explorer 14



Reprinting Specific Items
To reprint only specific parts of a print job, specify the exact items that you want to reprint. To do this,
use one of the following methods.

Using the Selected Print Job Details Pane to Reprint One or More Items

1. In the Selected Print Job Details pane, click the Reprint Labels tab, and then click to
select the check boxes in the Reprint column for the items that you want to reprint.

2. Click Reprint .

Alternatively, to reprint only one item, right-click it, and then click Reprint Item.

Using the Printed Item Preview Pane to Reprint One Item

You can reprint a single item by using the Printed Item Preview pane. To do this, select an item in
the Selected Print Job Details pane to display a preview image of that item in the Printed Item
Preview pane. Then, click the Reprint icon . Alternatively, right-click the image, and then click
Reprint Item.
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Printing a Print Job Overview Report
To print a detailed overview report of the selected print job, click the Overview tab of the Selected
Print Job Details pane, and then click Print to open the Preview dialog, which displays a preview
of the report document. In this dialog, you can configure the report to have a header or footer, print
the report, save it to a file or email it by using your default email application.
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Creating Reports
You can create reports of print jobs and security checks for any view in the History Explorer View
Selector pane. For example, you can print a report that shows all BarTender print jobs, jobs by
computer or jobs by document. This is a good way to pass along print history information to
managers and other teams and departments.

To create a report of the current view, click Export View on the File menu.

After you create the report, you can configure, print, export or email it from the Preview window.

Configuring a Report
You can use the toolbar options in Preview window to configure your report with the display
settings and printer settings that you want. For example, you can add a header and footer, add a
watermark, change the background color, or change the page margins and orientation. To
access advanced customization settings, click the Customize icon on the toolbar.

Printing a Report
To open the Print dialog so that you can modify the settings before you print, click Print on the
Preview window's toolbar. To print the report without opening the Print dialog, click the Quick
Print icon .

Exporting a Report
You can export the report in many different formats and to any
location on your computer or network. This process saves a
copy of the report that you can access later.

To export a report, follow these steps:

1. On the File menu of the Preview window, point to Export
Document, and then click the file format that you want.
An Export Options dialog opens that is specific to that
format.

2. Configure the format options that you want, and then
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click OK. The Save As dialog opens.
3. Browse to the location to which you want to export the file, and then click Save.

Emailing a Report
You can email the report in many different formats. To do this, follow these steps:

1. On the File menu of the Preview window, point to Send via E-Mail, and then click the file
format that you want. An Export Options dialog opens that is specific to that format.

2. Configure the format options that you want, and then click OK. The Save As dialog opens.
3. Click Save. Your email client opens with the file already attached.
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Related Documentation

White Papers
l BarTender System Security
l Reprint Console
l Printer Maestro

To view and download white papers, visit:

https://www.bartendersoftware.com/resources/white-papers/

Manuals
l Getting Started with BarTender

https://support.seagullscientific.com/hc/categories/200267887

BarTender Help System
l History Explorer
l Logging Application Messages
l Logging Permission Checks

Other Resources
Please visit the BarTender website at https://www.bartendersoftware.com.
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